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Úvod do 3D dat



Co je to 3D model

Počítačový soubor, případně více vzájemně propojených souborů

digitální záznam
obsahující informace o 
tvaru objektu a dalších 
vlastnostech

zobrazitelný ve 
speciálních aplikacích

Co to je digitální model? 



trojrozměrná reprezentace skutečného či uměle vytvořeného tvaru ve formě digitálních dat

věrný - reálný upravený smyšlený

Co to je digitální model? 



snadné sdílení 
bez ohledu na 
geografickou 
vzdálenost

široké vizualizační a 
analytické možnosti

animace a 
náhledy

měření a 
analýzy

3D tisk

snadná archivace s ohledem 
na prostorové možnosti, 
hygienické a etické otázky

vs.

Proč 3D modely používáme?

práce s digitálními 
modely ve virtuálním 
prostředí



Nejstručnější formát a zobrazení 3D modelů:

o soubor bodů definovaných trojrozměrnými 
souřadnicemi (x, y, z)

o body mohou být opatřeny informací o barvě
o body mohou být opatřeny normálovým 

vektorem (určuje rub a líc)

o vizualizace
o měření vzdáleností mezi body

o nevymezuje prostor

bodový oblakRůzné úrovně informace – bodový oblak



o body (vrcholy) propojené hranami (angl. edges), 
které vymezují plošky (facety, angl. faces); 
otevřený nebo uzavřený mnohostěn

o vizualizace
o měření vzdáleností mezi body na povrchu
o tvorba řezů, digitalizace křivek
o jednotlivé prvky mohou být opatřeny barevnou 

informací

o datově objemnější než bodový mrak

polygonální model (nalevo v umělém zabarvení, 
napravo v podobě drátěného modelu)

Různé úrovně informace – polygonální model



polygonální model s 
barevnou informací

nestínovaný polygonální model 
bez barevné informace

stínovaný polygonální 
model

aktuální podoba závisí na metodě záznamu, editaci modelu a nastavení zobrazení

Různé úrovně informace – polygonální síť a barevná informace



Malý úvod do 3D modelování

přiřazení  barvy přímo jednotlivým prvkům modelu (vrcholům, hranám nebo facetám) ->
závislost detailů barevného zobrazení na detailech modelu

5 000 vrcholů30 000 vrcholů70 000 vrcholů

Různé úrovně informace – typy barevné informace



Malý úvod do 3D modelování

textura – obrázek, kterým je model potažen

o samostatný obrazový soubor (např. jpg formát)

o barevná informace nezávislá na rozlišení modelu

o model uložen ve více souborech (soubor modelu + soubor 
materiálu + soubor textury)

5 000 vrcholů

Různé úrovně informace – typy barevné informace



.ply
o geometrie a barva 
o barva přiřazená vrcholům nebo ve 

formě textury

.obj
o geometrie, barva a materiálové 

vlastnosti
o barva ve formě informace přiřazené 

vrcholům i ve formě textury
o univerzální

.stl
o pouze geometrie
o dva formáty – Ascii a Binary – Ascii je uspořádanější, binary menší
o pokud polygonální sítě obsahují díry, některé programy hlásí chybu  

Formáty 3D modelů 

Existují velmi univerzální programy (např. Blender), ale také programy 
pracující s velmi omezeným množstvím formátů (např. Landmark).



PŘESNOST DIGITÁLNÍCH MODELŮ

Míra shody mezi vzájemnou polohou vrcholů 
modelu a vzájemnou polohou jim 
odpovídajících bodů zobrazovaného objektu 

ROZLIŠENÍ

Počet vrcholů modelu na jednotku 
plochy (nejčastěji in2 nebo cm2)

DETAILNOST

Velikost rozlišitelných 
prvků

523 vrcholů/cm2 

(70 Mb)
2 vrcholy/cm2 

(0,2 Mb)

Dáno přesností záznamových metod a 
následnými úpravami modelu

Co je to 3D model?Vlastnosti polygonální sítě



neexistuje jediná metoda, vhodná pro všechny typy objektů a zaznamenávající všechny vlastnosti!!!

vnitřní strukturavnější tvarbarevná informace

lékařské zobrazovací přístroje(CT a MRI)povrchové skenery a fotogrammetrie

Tvorba 3D modelů

(3D modelování zde ignorujeme)



o snímají 3D souřadnice bodů na povrchu objektů (základ polygonálního modelu)

o primárním výstupem jsou přímo 3D polygonální sítě nebo bodové mraky

o mohou snímat barevnost

o přesnost a rozlišení skenerů jsou dány technickými možnostmi použitých metod – až 
setiny mm 

Skenery a fotogrammetrie

kontaktní 
(dotykové) skenery

fotogrammetriespecializované, optické skenery

TOF

triangulační

laserové

pasivní

strukturované světlo

LiDAR



o prostorová poloha diskrétních bodů a křivek

o přesný záznam malého objemu dat

o použitelné na všechny pevné materiály

o pro snímání živých osob pomalé

Povrchové snímání – kontaktní skenery



o z jednoho bodu promítají jednu či více linií a z druhého bodu snímají 
deformaci jejich obrazu na povrchu objektu

o rozlišení až v řádu setin mm 

o záznam zpravidla v řádu jednotek či desítek sekund

o v Lamorfě skener NextEngine

Povrchové snímání – triangulační skenery – aktivní laserové skenery



Povrchové snímání – triangulační skenery – pasivní/optické skenery

o triangulují prostorové souřadnice z dvou a více snímků, pořízených 
synchronizovanými kamerami z různých úhlů

o rozlišení prvků na fotografiích -> ztotožnění -> výpočet prostorové polohy s 
rozdílů jejich uspořádání na různých fotografiích

o velmi rychlé (3,5 ms), designováno především na snímání živého člověka

o problém s ochlupenými a lesklými částmi těla

Vectra XT – celotělový skener 

o 6 kamer

o záznam hlavy a horní části 
trupu v rozsahu busty

o délka hrany polygonů v 
obličeji – 1,2 mm



Povrchové snímání – triangulační skenery – pasivní/optické skenery

Vectra H1 – ruční skener 

o 2 kamery

o záznamové pole 270mm (V) x 
165mm (Š) x 100mm (H)

o pro záznam obličeje nutné 
kombinovat více skenů

Vectra M1 – stolní obličejový skener

o 2 kamery

o pro záznam obličeje nutné 
kombinovat více skenů



Snímání povrchových 3D datPovrchové snímání – triangulační skenery – pasivní/optické skenery

o soustavy synchronizovaných fotoaparátů



Snímání povrchových 3D datPovrchové snímání – fotogrammetrická soustava ADAPT

50 synchronizovaných kamer s osvětlením



o generování 3D dat ze série fotografií pořízených 
fotoaparátem z různých úhlů

Snímání povrchových 3D dat

+ desítky dalších

Software
o rozezná stejné prvky na různých 

fotografiích
o na základě vzájemné polohy 

bodů na různých snímcích 
uspořádá fotografie v prostoru

o trianguluje trojrozměrnou 
podobu zaznamenaného, 
včetně barevné informace 

Povrchové snímání – fotogrammetrie



Bezpodmínečně potřebujete
o digitální fotoaparát
o počítač
o software

Povrchové snímání –fotogrammetrie

Hodí se
o stativ
o dálková spoušť fotoaparátu
o měřítko
o otočený stolek pro skenování 

samostatných kostí



Fotogrammetrie – snímání

Algoritmus získává veškeré informace o poloze a orientaci jednotlivých snímků v 
prostoru, distorzi optické soustavy a morfologii snímaných objektů z fotografií 



o každá část modelovaného povrchu musí být zobrazena na třech a více snímcích

(https://www.agisoft.com
/support/tips-tricks/)

Fotogrammetrie – snímání



o každá část modelovaného povrchu musí být zobrazena na třech a více 
snímcích

Fotogrammetrie – snímání



ca 110 fotografií

spojené sady

mumifikovaný 
levý palec

Povrchové snímání –snímky

o každá část modelovaného povrchu musí být zobrazena na třech a více snímcích



o metody zaznamenávají rozložení hmoty ve snímaném objemu 

o záznam vnitřní struktury, vnější podoby, ale ne barevnosti

o produktem nejsou 3D digitální modely, ale objemový záznam 

o relativně velké a finančně náročné (umístění, personál atd.)

výpočetní tomografie magnetická rezonance

Objemové snímání

snímání řezů modelem



Open-source program zaměřený na zpracování a editaci polygonálních modelů.

Import: PLY, STL, OFF, OBJ, 3DS, COLLADA, PTX, V3D, PTS, APTS, XYZ, GTS, TRI, 
ASC, X3D, X3DV, VRML, ALN
Export: PLY, STL, OFF, OBJ, 3DS, COLLADA, VRML, DXF, GTS, U3D, IDTF, X3D

+
velké množství nástrojů pro editaci bodových mraků 
a polygonálních sítí jako celku

generování statických náhledů na modely

pracuje s formáty .ply a .obj obsahujícími texturu.

-
časté bugy

omezené možnosti lokálních úprav

MeshLab – základní vlastnosti



File > Import > Import Mesh
nebo přetažením ikony do pracovního okna

 
Projekt je jednoduchý textový soubor (přípona .mlp), 
obsahuje pouze cesty k jednotlivým modelům, případně 
roto-translační matice, ne už záznamy jejich editace, 
definované body atp!!! V případě, že změníme cestu k 
modelům, projekt nenačteme!!!!!

Seznam importovaných 
objektů a nastavení jejich 
vykreslování.

Layer Dialog

Obecné požadavky na pojmenovávání modelů:
V cestě ani v názvu modelu nepoužívejte mezery a diakritiku
C:\modely_cviceni\H123_superior.stl

Pokud přejmenujeme vzájemně propojené soubory (např. obj s 
texturou), musíme změnit i odkazy (cestu) v samotných 
souborech. Historie příkazů

MeshLab – import dat



Navigace
LMB - otáčení
Ctrl + LMB – posouvání
kolečko myši – přibližování/oddalování
ctrl + h – návrat k originální poloze

LMB + Ctrl + Shift – ovládání osvětlení

shift + kolečko myši – změna FOV (field of view)

MeshLab – navigace

FOV = 7FOV = 90



Measuring tool

1) kliknutím LMB na model určíte krajní body 
vzdálenosti

Pokud je potřeba změnit mezi umístěním prvního a 
druhého bodu pohled, pak se z nástroje přepíná 
stiskem Esc nebo ikonou 

2) nástroj zobrazí hodnotu přímé vzdálenosti bodů

Při opětovném použití přibývají další rozměry.

MeshLab – měření a škálování modelů



Nástroje pro redukci počtu prvků jsou pod názvy začínajícími jako 
Simplification v menu Remeshing > Simplification and 
Reconstruction…

MeshLab – redukce modelu – snížení počtu prvků

Nejpoužitelnější je nástroj 
Simplification: Quadratic Edge 
Collapse Decimation ve verzi pro 
modely bez textury a pro 
modely s texturou (> With 
texture)

Nastavení cílového počtu facet

Volby zabraňující větším změnám v 
geometrii modelu. Při aktivaci bude 
zachováno směrování polygonů, 
redukce rozlišení nepovede ke změnám 
topologie modelu, např. vyplnění děr v 
modelu, a ke změnám tvaru děr v 
polygonální síti. 



MeshLab – měření a škálování modelů

Škálování

1) změřte referenční vzdálenost na modelu

2) vydělte skutečnou referenční vzdálenost naměřenou 
vzdáleností

3) o získaný koeficient zvětšete nebo zmenšete model

Filters > Normals, curvatures and orientations > 
Transform: scale…

uniform scaling – velikost změněna 
stejně ve všech třech dimenzích – 
nedochází ke změně tvaru

freeze matrix – dojde rovnou k 
přepočtu modelu, bez rototranslační 
matice



Export polygonálních modelů 
File > Export Mesh...

o změny modelu nepřepisují hned původní soubor
o změněný, ale neuložený model je v Layer Dialog onačen 

hvězdičkou
o pro změnu souboru modelu musí být změněný model 

exportován

Zadáme formát souboru a umístění

MeshLab – export dat

Nastavení součástí 
exportu
TexCoord – zásadní pro 
zachování textury!



Rekonstrukce a restaurace digitálních modelů

rekonstrukcerestaurace



nástroj Manipulator toolsMeshLab – posun a rotace modelu

informace o zvoleném 
modu a nápověda 
nástroje

ovládací gizma 
nástroje

aktivovaný 
model v Layer 
dialog

translační matice 
(neaplikovaná na 
model)



MeshLab – Manipulators Tools
o T, R, S – zvolíme požadovanou transformaci
o transformujeme při stisknutém LMB
o transformaci potvrdíme Enter

Transformací je na objekt aplikována tzv. roto-transformační matice

o každý model je umístěn na konkrétním místě vzhledem ke svému souřadnicovému 
systému (dáno hodnotou souřadnic vrcholů modelu)

o při změně pohledu (LMB atd.) se pohybuje kamerou!, poloha modelu vůči souřadnicové 
ose se musí změnit k tomu určenými nástroji

MeshLab – transformace modelů



Matice jsou součástí projektu MeshLab. Při načtení je objekt podle ní orientován, 
ale samotné souřadnice jeho vrcholů zůstávají nezměněny!!! 

proč? – například proto, že se při smazání matice „vrátí“ do původní polohy 

Aby se změnil samotný model, musí být na něj matice apikována!!!
o LMB na název objektu v Layer Dialog > Freeze Current Matrix (některá 

dialogová okna toto nabízejí rovnou)
o některé funkce (např. záznam souřadnic bodů) bez aplikace rototranslační 

matice nefungují

MeshLab – transformace modelů

o model je zobrazován s aplikovanou rototranslační maticí



Export náhledového okna ve formě obrázku (bitmapa)
1) nastavte požadovaný náhled v pracovním okně

2) otevřete dialogové okno Save snapshot

cílový adresář

název souboru

Nastavení rozlišení výsledného snímku v 
násobcích rozlišení náhledového okna

MeshLab – vytváření náhledů

nastavení pozadí



Export náhledového okna ve formě obrázku (bitmapa)
1) nastavte požadovaný náhled v pracovním okně

2) otevřete dialogové okno Save snapshot

cílový adresář

název souboru

Nastavení rozlišení výsledného snímku v 
násobcích rozlišení náhledového okna

MeshLab – vytváření náhledů

nastavení pozadí



MeshLab – záznam 3D souřadnic bodů

1) spusťte nástroj PickPoints

2) body umisťujte kliknutím RMB na 
model. Dalším kliknutím RMB umístíte 
další bod

tyto volby slouží pro uložení 
a tvorbu šablony, do které se 
body zanášejí

tyto volby slouží pro 
uložení a nahrání 
souborů se souřadnicemi

tyto volby slouží k editaci 
zaznamenaných dat 
(názvů jednotlivých bodů)

nastavení viditelnosti a způsobu 
zobrazení normály

pokud potřebujete změnit 
polohu kamery, aktivujte volbu 
Not editing

Pro záznam bodů si můžete 
předpřipravit šablonu přidáním řádků 
pro body (Add point), jejich 
pojmenováním (Rename Point) a 
uložením konečné šablony (Template 
Controls > Save) 
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